# Overview

## 1 Release Information

1.1 General

1.2 Prerequisites

1.3 System requirements

1.4 Simulation Models

## 2 What’s New in 5.60

2.1 New graphics engine based on DirectX11

2.2 Migrate backup

2.3 Tags

2.4 Track motion in Online Monitor

2.5 IRB 6700

2.6 IRB 360 6kg / 1.6m

2.7 Motor units MU and gear units MID

2.8 ScreenMaker Widgets

2.9 Other changes in RobotStudio 5.60

## 3 Late Breaking Information

## 4 Corrections

4.1 Corrections in RobotStudio 5.60

## 5 Known Limitations

5.1 General

5.2 Online

5.2.1 Online - Paint

5.2.2 Online – Integrated Vision

5.3 Offline
# Table of Contents

5.3.1 General 28  
5.3.2 Station Viewer 29  
5.3.3 Signal Analyzer 29  
5.3.4 MultiMove 30  
5.3.5 Virtual FlexPendant 30  
5.3.6 External Axis 31  
5.3.7 Network Drives and UNC Paths 31  
5.3.8 RAPID 32  
5.3.9 Building Controller systems 33  
5.3.10 Paint 33  
5.3.11 Conveyor Tracking 34  
5.3.12 Graphics and Geometry 34  
5.3.13 Gearbox Heat Prediction Tool 35  
5.3.14 External Axis Wizard 35  

5.4 ScreenMaker Limitations 35  

6 RobotWare Compatibility 38  

6.1 General 38  

6.2 RobotWare 5.05 and 5.06 Compatibility 38  

6.3 RobotWare 5.07 Compatibility 38  

6.4 RobotWare 5.08 Compatibility 38  

6.5 RobotWare 5.10 Compatibility 38  

6.6 RobotWare 5.11 Compatibility 39  

6.7 RobotWare 5.12 Compatibility 39  

6.8 RobotWare 5.13 Compatibility 39  

6.9 RobotWare 5.15 Compatibility 40  

6.10 General Compatibility Limitations 40  

6.11 ScreenMaker Compatibility 40  

6.12 Support for future RobotWare versions 41  

7 Installation information 42  

7.1 Installing RobotStudio 42  

8 Technical support 45  

8.1 Overview 45
Overview

Description

This document provides information about the new features, problems corrected, and installation of RobotStudio.

Product Overview

RobotStudio lets you install, configure, and program ABB robots. You can do this both offline, using virtual robots, and online, connected to real robots.

RobotStudio is categorized into the following two feature levels:

- **Basic** - Offers selected RobotStudio functionality to configure, program, and run a virtual controller. It also includes online features for programming, configuring, and monitoring a real controller connected over Ethernet.

- **Premium** - Offers full RobotStudio functionality for offline programming and simulation of multiple robots. The Premium level includes the features of the Basic level and requires activation.

RobotStudio offers the following installation options:

- **Minimal** - Installs only the features required to program, configure, and monitor a real controller connected over Ethernet.

- **Complete** - Installs all the features required to run the complete RobotStudio. If installed with this option, additional features of Basic and Premium functionality are available.

- **Custom** - Installs user-customized features. This option allows excluding unwanted robot libraries and CAD converters.

**Note**

**RobotStudio 64-bit edition** is installed for the *Complete* installation option on computers with a 64-bit operating system. The 64-bit edition allows large CAD-models to be imported as more memory can be addressed. However, the 64-bit edition has the following limitations:

- Integrated Vision is not supported
- SafeMove Configurator is not supported
- EPS Wizard is not supported
- ScreenMaker is not supported
- Add-ins will be loaded from the following folder
- C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.60\Bin64\Addins
1 Release Information

1.1 General

Release Name
The release name is RobotStudio 5.60 and the build number is 5.60.5731.0084.

Release Date
The release date is November 29th, 2013.

CAD Converter Options
The CAD Converter options can be set by using the Advanced button of the Settings dialog of the CAD Converter. By pressing the Advanced button, the CADConverter.ini file is opened. The file specifies all available options for CAD conversion. To change an option, simply uncomment the line by removing the semicolon and modify the option as desired. All options are described in the file ‘AcisInterOpConnectOptions.pdf’ in the RobotStudio folder of the RobotWare DVD.

Demo stations
There are two demo stations included in this version.
- Demo AW Station
- Demo Solar Simulation
- Demo TwoRobotsAndConveyor.rspag (requires RobotWare 5.151)

They are stored in the Pack & Go format (.rspag) and can be opened with the command Unpack & Work on the Share section of the RobotStudio menu.

1 A download for RobotWare 5.15.0x (the latest available revision of RobotWare 5.15) will be presented in the Unpack&Work wizard if no compatible RobotWare version is installed.

ScreenMaker Demo Station and Project
There is a demo station and associated ScreenMaker project available.
- SCM_ExampleProject (ScreenMaker Project)
- SCM_ExampleStation (RobotStudio station)

These files are found in the ‘Addins/ScreenMaker/Samples’ folder under the RobotStudio installation folder.

Tutorials
Tutorials are available at the RobotStudio product pages at http://www.abb.com/roboticssoftware

Language Support
RobotStudio is available in the following seven languages: English, French, German, Spanish, Italian, Japanese, and Chinese (simplified).

ScreenMaker supports only English when building the application in RobotStudio. ScreenMaker Designer does not provide a localization tool. Therefore, applications created with ScreenMaker will display the same text specified at design time, regardless of the choice of language on the FlexPendant.
If Asian languages are used (Chinese, Japanese, Korean) then these screens will display correctly only when the FlexPendant language matches the ScreenMaker language. Otherwise empty markers will appear where the text characters should be.

Documentation

User documentation for RobotStudio is available from the Help button ( ) in the upper-right corner of RobotStudio.

The complete documentation in PDF for RobotWare including RobotStudio is available on DVD and can be ordered separately from ABB

1.2 Prerequisites

Before you install...

Before you begin installing RobotStudio, you must have Administrator privileges to successfully complete the installation.

On Windows 8.1, ScreenMaker users need to install the .NET Framework 3.5 according to this Microsoft instruction: http://msdn.microsoft.com/en-us/library/hh506443

Licensing

RobotStudio is categorized into the following two feature levels:

- Basic - Offers selected RobotStudio functionality to configure, program, and run a virtual controller. It also includes online features for programming, configuring, and monitoring a real controller connected over Ethernet.
- Premium - Offers full RobotStudio functionality for offline programming and simulation of multiple robots. The Premium level includes the features of the Basic level and requires activation.

RobotStudio 64 bit

RobotStudio 64-bit edition is installed for the Complete installation option on computers that have a 64-bit operating system. The 64-bit edition allows large CAD-models to be imported as it can address more memory than the 32-bit version. However, the 64-bit edition has the following limitations:

- Integrated Vision is not supported
- SafeMove Configurator is not supported
- EPS Wizard is not supported
- ScreenMaker is not supported
- Add-ins will be loaded from the following folder
  C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.60\Bin64\Addins

1.3 System requirements

Software requirements

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows 7 SP1</td>
<td>32-bit edition</td>
</tr>
<tr>
<td>Microsoft Windows 7 SP1 (recommended)</td>
<td>64-bit edition</td>
</tr>
<tr>
<td>Microsoft Windows 8.1 (recommended)</td>
<td>64-bit edition</td>
</tr>
</tbody>
</table>
### Hardware Requirements

<table>
<thead>
<tr>
<th></th>
<th><strong>2.0 GHz or faster processor, multiple cores recommended</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>3 GB if running Windows 32 bit edition</td>
</tr>
<tr>
<td></td>
<td>8 GB if running Windows 64 bit edition.</td>
</tr>
<tr>
<td>Free disk space</td>
<td>5+ GB free space</td>
</tr>
<tr>
<td>Graphics card</td>
<td>High-performance DirectX 11 compatible graphics card.</td>
</tr>
<tr>
<td></td>
<td>For the Advanced lightning mode Direct3D feature level 10_1 or higher is required.</td>
</tr>
<tr>
<td>Screen resolution</td>
<td>1920 x 1080 pixels or higher is recommended</td>
</tr>
<tr>
<td>DPI</td>
<td>Normal size (100% / 96 dpi) up to Large size (150% / 144 dpi)</td>
</tr>
<tr>
<td>Mouse</td>
<td>Three-button mouse</td>
</tr>
<tr>
<td>3D Mouse [optional]</td>
<td>Any 3D mouse from 3DConnexion, see <a href="http://www.3dconnexion.com">http://www.3dconnexion.com</a></td>
</tr>
<tr>
<td>Disk Drive</td>
<td>DVD-ROM Drive (required only if you receive the RobotStudio installer on a DVD).</td>
</tr>
</tbody>
</table>
## 1.4 Simulation Models

### Robot Libraries

<table>
<thead>
<tr>
<th>Variant</th>
<th>Library name</th>
</tr>
</thead>
<tbody>
<tr>
<td>120 3kg/0.5m</td>
<td>IRB120_3_58_01.rslib</td>
</tr>
<tr>
<td>120T 3kg/0.5m</td>
<td>IRB120T_3_58_01.rslib</td>
</tr>
<tr>
<td>140 5kg/0.8m Type A/B</td>
<td>IRB140_5_81_A_01.rslib</td>
</tr>
<tr>
<td>140 5kg/0.8m Type C</td>
<td>IRB140_5_81_C_01.rslib</td>
</tr>
<tr>
<td>140 5kg/0.8m Type C</td>
<td>IRB140T_5_81_C_01.rslib</td>
</tr>
<tr>
<td>1400 Type A/B</td>
<td>IRB1400_5_144_01.rslib</td>
</tr>
<tr>
<td>1400H Type A/B</td>
<td>IRB1400H_5_128_01.rslib</td>
</tr>
<tr>
<td>1520ID</td>
<td>IRB1520ID_4_150_01.rslib</td>
</tr>
<tr>
<td>1600 5kg/1.2m</td>
<td>IRB1600_5_120_01.rslib</td>
</tr>
<tr>
<td>1600 5kg/1.2m Type A</td>
<td>IRB1600_5_120_A_01.rslib</td>
</tr>
<tr>
<td>1600 5kg/1.45m</td>
<td>IRB1600_5_145_01.rslib</td>
</tr>
<tr>
<td>1600 6kg/1.2m</td>
<td>IRB1600_6_120_02.rslib</td>
</tr>
<tr>
<td>1600 7kg/1.2m</td>
<td>IRB1600_7_120_01.rslib</td>
</tr>
<tr>
<td>1600 7kg/1.45m</td>
<td>IRB1600_7_145_01.rslib</td>
</tr>
<tr>
<td>1600 10kg/1.2m</td>
<td>IRB1600_10_120_01.rslib</td>
</tr>
<tr>
<td>1600 10kg/1.45m</td>
<td>IRB1600_10_145_01.rslib</td>
</tr>
<tr>
<td>1600ID 4kg/1.5m</td>
<td>IRB1600ID_4_150_03.rslib</td>
</tr>
<tr>
<td>2400 10kg</td>
<td>IRB2400_10_150_02.rslib</td>
</tr>
<tr>
<td>2400 16kg</td>
<td>IRB2400L_18_150_02.rslib</td>
</tr>
<tr>
<td>2600 12kg/1.65m</td>
<td>IRB2600_12_165_01.rslib</td>
</tr>
<tr>
<td>2600 20kg/1.65m</td>
<td>IRB2600_20_165_01.rslib</td>
</tr>
<tr>
<td>2600 12kg/1.85m</td>
<td>IRB2600_12_185_01.rslib</td>
</tr>
<tr>
<td>2600ID 8kg/2.0m</td>
<td>IRB2600ID_8_200_01.rslib</td>
</tr>
<tr>
<td>2600ID 15kg/1.85m</td>
<td>IRB2600ID_15_185_01.rslib</td>
</tr>
<tr>
<td>260</td>
<td>IRB260_30_150_02.rslib</td>
</tr>
<tr>
<td>340</td>
<td>IRB340_01.rslib</td>
</tr>
<tr>
<td>360 1kg/1130 Standard No axis 4</td>
<td>IRB360_1_1130_3D_STD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1130 Wash-down No axis 4</td>
<td>IRB360_1_1130_3D_UD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1130 Stainless</td>
<td>IRB360_1_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Wash-down</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 3kg/1130 Stainless</td>
<td>IRB360_3_1130_4D_WD_03.rslib</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>IRB360_1_1600_4D_STD_02.rslib</td>
</tr>
</tbody>
</table>

**Additional libraries not listed above.**
** requires the Stand Alone Controller mediapool that is available on the RobotWare 5.60 DVD.

**Note**

All simulation models in the table are installed with RobotStudio, but only the robots in the current product range are displayed in the ABB Library gallery. To import any other robot you need to browse to the file on disk.
Robot Libraries

<table>
<thead>
<tr>
<th>Variant</th>
<th>Library name</th>
</tr>
</thead>
<tbody>
<tr>
<td>52 short vertical arm</td>
<td>IRB52_12_475_1005_01.rslib</td>
</tr>
<tr>
<td>52 std vertical arm</td>
<td>IRB52_12_700_1005_01.rslib</td>
</tr>
<tr>
<td>540-12 std arm</td>
<td>IRB540_12_1000_1620_01.rslib</td>
</tr>
<tr>
<td>580-12 std arm</td>
<td>IRB580_12_1000_1620_02.rslib</td>
</tr>
<tr>
<td>580-12 short arm</td>
<td>IRB580_12_1000_1220_01.rslib</td>
</tr>
<tr>
<td>5300-12 left</td>
<td>IRB5300_12L_804_530_01.rslib</td>
</tr>
<tr>
<td>5300-12 right</td>
<td>IRB5300_12R_804_530_01.rslib</td>
</tr>
<tr>
<td>5320-1500</td>
<td>IRB5320_1500</td>
</tr>
<tr>
<td>5320-2000</td>
<td>IRB5320_2000</td>
</tr>
<tr>
<td>5350/01 Type Left Side Left</td>
<td>IRB5350_02L_804_547_L_01.rslib</td>
</tr>
<tr>
<td>5350/01 Type Left Side Right</td>
<td>IRB5350_02L_804_547_R_01.rslib</td>
</tr>
<tr>
<td>5350/02 Type Right Side Left</td>
<td>IRB5350_02R_804_547_L_01.rslib</td>
</tr>
<tr>
<td>5350/02 Type Right Side Right</td>
<td>IRB5350_02R_804_547_R_01.rslib</td>
</tr>
<tr>
<td>5400-12 std arm</td>
<td>IRB5400_12_1200_1620_02.rslib</td>
</tr>
<tr>
<td>5400-13 std arm</td>
<td>IRB5400_13_1200_1620_02.rslib</td>
</tr>
<tr>
<td>5400-14 std arm</td>
<td>IRB5400_14_1200_1620_02.rslib</td>
</tr>
<tr>
<td>5400-22 process arm</td>
<td>IRB5400_22_1200_1620_02.rslib</td>
</tr>
<tr>
<td>5400-23 process arm</td>
<td>IRB5400_23_1200_1620_02.rslib</td>
</tr>
<tr>
<td>5400-24 process arm</td>
<td>IRB5400_24_1200_1620_02.rslib</td>
</tr>
<tr>
<td>5400-12 std arm axis 2 +60 deg</td>
<td>IRB5400_12_1200_1620_60P_01.rslib</td>
</tr>
<tr>
<td>5400-13 std arm axis 2 +60 deg</td>
<td>IRB5400_13_1200_1620_60P_01.rslib</td>
</tr>
<tr>
<td>5400-14 std arm axis 2 +60 deg</td>
<td>IRB5400_14_1200_1620_60P_01.rslib</td>
</tr>
<tr>
<td>5500 35A b_00 / b_80</td>
<td>IRB5500_35A_1300_1720_02.rslib</td>
</tr>
<tr>
<td>5500 35B b_00 / b_80</td>
<td>IRB5500_35B_1300_1720_02.rslib</td>
</tr>
<tr>
<td>5500 ProArm 35A b_00 / b_80</td>
<td>IRB5500_ProArm_A_1300_1720_03.rslib</td>
</tr>
<tr>
<td>5500 ProArm 35B b_00 / b_80</td>
<td>IRB5500_ProArm_B_1300_1720_03.rslib</td>
</tr>
</tbody>
</table>

Track Libraries

RobotStudio is distributed with the following track types that are available in the Track folder of the ABB Library.

<table>
<thead>
<tr>
<th>Track family</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>IRBT4003</td>
<td>1.7 m to 10.7 m</td>
</tr>
<tr>
<td>IRBT4004</td>
<td>1.9 m to 19.9 m</td>
</tr>
<tr>
<td>IRBT6003</td>
<td>1.7 m to 10.7 m</td>
</tr>
<tr>
<td>IRBT6004</td>
<td>1.7 m to 19.7 m</td>
</tr>
<tr>
<td>IRBT7003</td>
<td>1.7 m to 10.7 m</td>
</tr>
<tr>
<td>IRBT7004</td>
<td>1.7 m to 19.7 m</td>
</tr>
<tr>
<td>RTT_Bobin</td>
<td>1.7 m to 11.7 m</td>
</tr>
<tr>
<td>RTT_Marathon</td>
<td>1.7 m to 11.7 m</td>
</tr>
<tr>
<td>Paint Rails</td>
<td>2 m to 20 m</td>
</tr>
<tr>
<td>left and right versions</td>
<td></td>
</tr>
<tr>
<td>IRB5350 Rail</td>
<td>3 m to 10 m</td>
</tr>
<tr>
<td>left and right versions</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

To use the IRBTX004 tracks the user must install the Track mediapool from the RobotStudio/RobotWare distribution.
Positioner Libraries

RobotStudio 5.13.02 and later is distributed with the M2009 generation of positioners of type IRBP A, B, C, D, K, L and R and MTD. This represents the complete product range of the M2009 positioner series. The positioner libraries will be generated when the user selects the library from the menu ‘ABB Library’ gallery of the ‘Home’ tab of RobotStudio. The imported library will by default be part of the station. A consequence is that part positions can be modified. To prevent the library from being accidentally modified, it should be saved as a library. This can be done using the ‘Save As Library’ command.

The reason for not distributing the pre-compiled libraries is to reduce maintenance and footprint as the libraries are sharing many components. The function ‘System From Layout’ supports the new positioner generation and can be used to build a matching system.

Note

The M2001 library generation is available and can be imported using the Browse for Library command.
2 What’s New in 5.60

Overview

This section contains information on the new features of RobotStudio 5.60

2.1 New graphics engine based on DirectX11

Overview

The DirectX 11 based 3D graphics engine in RobotStudio enables the user to customize the light setup by adding and tuning the light sources available: ambient light, infinite light, spotlight and point light. The shadows cast by the objects in combination with the built-in material library gives a realistic touch to the visualization of your result.

Advanced lightning mode

Shadows and lights are enabled in the Advanced lightning mode. The mode is optimized for visual appearance. The mode enables the various light sources to be configured and saved as presets. You can add materials (textures) to your parts to make them look more realistic. The built-in material library provides a basic set of material, e.g. brushed metal, copper, concrete etc. The library can be extended with your own customized materials. The advanced lightning mode is typically used when creating movies and Station Viewers for visualization of your result.

When working with layout and programming the Advanced lightning mode can be disabled. Then the 3D view is optimized for performance and visibility.

In the RobotStudio options, you can select if the Advanced lightning mode shall be the default.
Graphics tools

The graphics functions have been collected in the the Graphics Tools tab that is opened by pressing the button with the same name of the Home tab.

Clip planes

A clip plane is an infinite plane that cuts through geometric objects in the station. Objects on one side of the plane are visible while objects on the other side are invisible. A station can contain multiple clip planes, but each graphics view can only have one active clip plane.
Light sources

In the Advanced Lightning mode, you can setup four different light sources and combine to meet your needs.

**Ambient light.** Basic background light that affects all objects equally. No shadows

**Infinite light.** Parallel light from infinitely far away. Direction can be changed. Casts shadows

**Spotlight.** Light originates from a single point, and spreads outward in a cone. Direction and location can be changed. Casts shadows

**Point light.** Light originates from a single point, and spreads outward in all directions. No shadows.

Materials and textures

The predefined material and texture library contains common materials that can be applied to graphical objects. You can also add your own materials or customize the existing ones.
2.2 Migrate backup

*Migrate backup* is a pre-installed add-in to RobotStudio. The tool helps in migrating IRC5 backups from RobotWare versions 5.15 and earlier to RobotWare versions 5.60 and later.

To use the tool, press *Migrate backup* in the Add-Ins tab and then select the controller backup you want to migrate. Click OK to start the migration. Information about the migration progress will be displayed in the output window. After migration, configuration files that contain incompatibilities are opened in a text editor. Configuration parameters that are not migrated automatically will be commented out together with an explanation. These parameters must be migrated manually.

The backup is ready to be restored when migration is completed for all incompatible files. Incompatible configuration files are retained in the SYSPAR folder with *.bak extension.

For details about the changes in the configuration parameters for RobotWare 5.60, check the *Migration guideline* that is available from the Help button of the tool.

The Migrate backup tool is available in English only, both the user interface and the Migration Guide.

2.3 Tags

**Overview**

For a complex RobotStudio station containing many robots, parts, paths, targets and other objects the browser and the 3D graphics view becomes cluttered. *Tags* help the user to group objects in the 3D graphics view and in the browser during station modeling and offline programming.

Using tags, you can group objects in a defined structure by labeling them. It is possible to hide or show these tags independent of the other tags. A hidden tagged object is invisible in the browser and in the 3D graphics window unless it is labeled by a currently visible tag.
Example:

The three pictures below show a station with two tags.

When all tags are disabled only objects with no tag is visible.

When Tag_1 is enabled then objects tagged with Tag_1 and untagged objects are visible.

When Tag_2 is enabled then objects tagged with Tag_2 and untagged objects are visible.

2.4 Track motion in Online Monitor

Overview

Track motions can now be displayed in the Online monitor, when connected to a robot mounted on a track motion. The geometry of the track motion is automatically generated based on the parameters in the controller (min and max limits).

2.5 IRB 6700

Overview

The new robot IRB 6700 is available in six sizes with payloads in the range of 150-235 kg and working ranges of 2.6 - 3.2 m.
Each robot size can be ordered with one of four different dress pack variants.

2.6 IRB 360 6kg / 1.6m

Overview

The FlexPicker family has been extended with a 6 kg version of the large FlexPicker with 1.6m working range.
2.7 Motor units MU and gear units MID

Overview
The ABB Robotics motor units MU100-400 and the motor units MID 500 and 1000 are available in RobotStudio 5.60 and supported by the function System From Layout.

2.8 ScreenMaker Widgets

Overview
A widget is a visual building block, containing an information arrangement, which represents an aspect of a robot application. It is a reusable and sharable user interface building block which can help speed up the development of screens. The widgets can then be used in ScreenMaker applications and in Production Screen.

2.9 Other changes in RobotStudio 5.60

Robots and equipment available in ABB Gray
All ABB robots and equipment in the ABB Gallery import tool are available in gray color known to color specialists as RAL 7035/Pantone 428 C) and red ABB logo. This is the new standard color of the ABB industrial robots. The robot models are also still available in orange and can manually imported using the “Import Library” option by browsing to the files on disk. Whenever a robot is available in both gray and orange, the library name will contain the "_G_" suffix.
Robots whose standard color is white are not affected, they will remain in white.

Improved RAPID sync performance
The performance for RAPID sync has been improved.
Stop At Collision improvements

The function Stop At Collision has been improved to stop exactly at the point of collision (or near miss). The simulation is paused at the collision point and can be resumed by the user. Note that the virtual time mode must be set to Time Slice. If using Free Run mode, the behavior will be as in RobotStudio 5.15, where the stop is initiated at the collision, but the robot requires a certain time to stop the motion.

Visual Studio Tools for Applications discontinued

Visual Studio Tools for Applications has been discontinued and is no longer available in RobotStudio.

Windows XP and Vista support discontinued

Windows XP and Vista are not supported by RobotStudio 5.60.

Compatible with RobotWare 5.60 and earlier

RobotStudio 5.60 is compatible with RobotWare 5.60 down to 5.07.

RobotWare 5.15 is optionally available for download in Unpack&Work when required

RobotStudio Pack&Go files (.rsPag) based on RobotWare 5.15.02 or earlier cannot be opened with RobotWare 5.60. If no compatible RobotWare version is installed the user will be able to download the latest revision of RobotWare 5.15 through a download link that is displayed.
Import of RobotStudio S4 4.0 stations and libraries no longer supported

It is no longer possible to import stations and libraries from RobotStudio S4 4.0.

Discontinued 3D formats

Import of PLY, Jupiter and VRML1 formats are no longer supported. (Note that VRML2 is still supported.)

System Builder Download lists compatible controllers

The list of controller presented when selecting a system in System Builder and pressing the Download button will only show controllers that are compatible with the selected system. If the system selected is based on RobotWare 5.15, or earlier only controllers with the ULC1 main computer will be listed. If the selected system is based on RobotWare 5.60 or later, only controller with the RAC main computer will be listed.
3 Late Breaking Information

Overview

This section contains information about late changes that were done after the RobotStudio 5.60 Operating Manual was finalized.

Signal Analyzer Online not available for RobotWare 5.60, RobotWare 5.15.02 and earlier

The feature Signal Analyzer Online is no longer available for controllers running RobotWare 5.60, RobotWare 5.15.02 and earlier. The reason is a vulnerability in Robotware that may cause interruptions in the robot operation.

Signal Analyzer Online will be supported by Robotware 5.15.03, available December 2013, and RobotWare 5.61, available Q2 2014, where the problem has been corrected.

It is not recommended to use Signal Analyzer Online of RobotStudio 5.15.01 or 5.15.02 with RobotWare prior to 5.15.03 or 5.61.

Creating Production Screen Widget

ScreenMaker helps the user to create two kinds of widgets, Production Screen widget and Standard widget. Controls in a widget can be bound to rapid or signal data.

The Production Screen option is a framework for creating a customized GUI that can be used to present process data and status and execute FlexPendant applications.

To run widgets on the Production Screen, FlexPendant Interface option must be selected.

For more information on Production Screen, please see

Use the following procedure to create the Production Screen widget.

1. In the Screenmasker ribbon, select New. The New Project dialog opens
2. Select Widget Template to create a new widget project.
3. Drag and drop controls to the widget.
5. Under Type, click Production Screen and click OK.
6. Build the project.

To view the widget created in Production Screen, ProductionSetup.xml file must be updated with widget details. You can find ProductionSetup.xml under $System\HOME\ProdScr, then place 'Widget components' under $System\HOME\ProdScr\tps

An example of widget detail is provided here:

```xml
<Widget>
  <Name>Widget_9</Name>
  <Page>1</Page>
  <Assembly>Widget_9.dll</Assembly>
  <Type>Widget_9.Widget_9</Type>
  <Position>
    <X>1</X>
    <Y>1</Y>
  </Position>
  <ZIndex>1</ZIndex>
  <Bindings>
    <Binding PropertyName="led1.Value" BindingType="SIGNAL" DataName="MOTLMP" />
    <Binding PropertyName="button1.Text" BindingType="RAPID" DataName="T_ROB1/ easily\wobj6" />
  </Bindings>
</Widget>
```

The production screen provides enough flexibility to modify the bindings of the widget. This is provided under Bindings tag as shown here:

```xml
<Bindings>
  <Binding PropertyName="led1.Value" BindingType="SIGNAL" DataName="MOTLMP" />
  <Binding PropertyName="button1.Text" BindingType="RAPID" DataName="T_ROB1/ BASE\wobj6" />
</Bindings>
```
4 Corrections

Overview
This section describes the defects solved in RobotStudio.

4.1 Corrections in RobotStudio 5.60

Overview
This section describes the corrections made in 5.60

Product Defect Documents

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>117</td>
<td>Leftovers from RobotStudio Uninstall</td>
</tr>
<tr>
<td>217</td>
<td>Path tool compensation fails</td>
</tr>
<tr>
<td>547</td>
<td>Autopath: const dist causes exception (min value should be 0.1)</td>
</tr>
<tr>
<td>694</td>
<td>IRBT Track and SafeMove in Robot Studio</td>
</tr>
<tr>
<td>1115</td>
<td>Path tool compensation not working correctly</td>
</tr>
<tr>
<td>1199</td>
<td>RobotStudio List of existing system does not update</td>
</tr>
<tr>
<td>1320</td>
<td>Module does not open in the right view</td>
</tr>
<tr>
<td>1324</td>
<td>Compare RAPID unwanted handle left</td>
</tr>
<tr>
<td>1340</td>
<td>character for tab stop drawn within the RAPID code characters</td>
</tr>
<tr>
<td>1399</td>
<td>Interpolate path creates to big final interpolation step</td>
</tr>
<tr>
<td>1401</td>
<td>Applied texture replaces icons in graphic view</td>
</tr>
<tr>
<td>1413</td>
<td>RobotStudio AutoComplete doesn't find GOTO labels</td>
</tr>
<tr>
<td>1562</td>
<td>Signalanalyser: Failed to subscribe on signal</td>
</tr>
<tr>
<td>1639</td>
<td>Autopath does not set the orientation correctly for circular paths</td>
</tr>
<tr>
<td>1734</td>
<td>Mech. unit name not shown anymore for mapping library at VC startup</td>
</tr>
<tr>
<td>1740</td>
<td>Display error in VC tree</td>
</tr>
<tr>
<td>1747</td>
<td>RS Editor zoom scaling: it should be possible to define the used default setting</td>
</tr>
<tr>
<td>1750</td>
<td>RS Editor: Format RAPID issues</td>
</tr>
<tr>
<td>1755</td>
<td>RS5.15 Autofill for data declaration does not work local in procedure</td>
</tr>
<tr>
<td>1756</td>
<td>RS5.15 Editor semantic check not working for arguments within a function call</td>
</tr>
<tr>
<td>1784</td>
<td>Crash while multi robot jogging in linear and reorientation mode (jog joint OK)</td>
</tr>
<tr>
<td>1805</td>
<td>GoOffline with add. option mediapool might fail</td>
</tr>
<tr>
<td>1810</td>
<td>RobotStudio Crash enabling a multi jog in MultiMove System</td>
</tr>
<tr>
<td>1820</td>
<td>RAPID editor provides also procedures instead of only functions in the selection list, when doing an assignment to a variable</td>
</tr>
<tr>
<td>1822</td>
<td>Global instructions and functions of installed modules are not shown in auto completion list of RAPID editor</td>
</tr>
<tr>
<td>1846</td>
<td>Bad performance with tool compensation</td>
</tr>
<tr>
<td>1891</td>
<td>Backup not possible from RS</td>
</tr>
<tr>
<td>1912</td>
<td>Not possible to open station viewer</td>
</tr>
<tr>
<td>1953</td>
<td>Problem with AutoPath incl. app crash</td>
</tr>
<tr>
<td>2000</td>
<td>Backup problems in RW 15</td>
</tr>
<tr>
<td>Issue</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>2005</td>
<td>Accidental loading of 6.0 alpha into old 5.15 computer</td>
</tr>
<tr>
<td>2028</td>
<td>RS5.15.01RC2: Safety zones not shown correctly in OnlineMonitor for robot on track</td>
</tr>
<tr>
<td>2033</td>
<td>Help for Online Monitor Safety Zones missing</td>
</tr>
<tr>
<td>2036</td>
<td>Old expired license info still present</td>
</tr>
<tr>
<td>2076</td>
<td>RobotStudio Vision tab greyed out</td>
</tr>
<tr>
<td>2083</td>
<td>The &quot;terminal&quot; function in the &quot;Controller&quot; tab is not documented in the RobotStudio help</td>
</tr>
<tr>
<td>2112</td>
<td>RobotStudio Adjust Robtarget Documentation errors</td>
</tr>
<tr>
<td>2137</td>
<td>New leftovers from RobotStudio Uninstall</td>
</tr>
<tr>
<td>2164</td>
<td>Incorrect warning dialog when setting PP to main</td>
</tr>
<tr>
<td>2187</td>
<td>RS Crash from opening MOC</td>
</tr>
<tr>
<td>2193</td>
<td>Integrated Vision – French localization errors</td>
</tr>
<tr>
<td>2196</td>
<td>VRML import does not work properly</td>
</tr>
<tr>
<td>2200</td>
<td>Tool flange of IRB6640ID at calibration position</td>
</tr>
<tr>
<td>2203</td>
<td>RobotStudio crash importing a STEP file</td>
</tr>
<tr>
<td>2205</td>
<td>Not possible to select ALL if saving event logs</td>
</tr>
<tr>
<td>2206</td>
<td>Not possible to save event log IO and communication with german RS</td>
</tr>
<tr>
<td>2222</td>
<td>Missing configurations for an IRB 140</td>
</tr>
<tr>
<td>2224</td>
<td>RAPID Editor issue in RS</td>
</tr>
<tr>
<td>2238</td>
<td>Aggregate Exception when sync to VC</td>
</tr>
<tr>
<td>2306</td>
<td>Errors in AutoConf not showing Cfx=3 solutions on different Paths</td>
</tr>
<tr>
<td>2333</td>
<td>Errors importing positioners from ABB Library</td>
</tr>
<tr>
<td>2339</td>
<td>Smart component stops station from loading</td>
</tr>
<tr>
<td>2353</td>
<td>Signal Analyzer – Problem with 'target changed' signal display</td>
</tr>
<tr>
<td>8255</td>
<td>Ambiguous HMI status after PC has been in sleep mode</td>
</tr>
<tr>
<td>8851</td>
<td>Feature request: RAPID Diff: 'Previous diff' and 'show only diffs'</td>
</tr>
<tr>
<td>9517</td>
<td>Not possible to restart a task stopped in RS task window</td>
</tr>
<tr>
<td>9847</td>
<td>Cannot create Rapid NOVIEW module</td>
</tr>
</tbody>
</table>
5 Known Limitations

Overview

This section describes known limitations in RobotStudio.

5.1 General

*Migrate backup and CAD conversion requires a PC reboot on Windows 8.1*

It is required to reboot your PC after installation of RobotStudio for the features Migrate Backup and CAD conversion to work as expected. The reason is that required environment variables created by the RobotStudio installer is not available until after a reboot. This is a limitation in Windows 8.1.

**Warning about duplicate files appear when multiple versions of same PowerPac is installed**

When two or more versions of the same PowerPac is installed, warning messages appear in the Output window when RobotStudio is started. The warning messages inform that duplicate files are installed. The message can be ignored since the PowerPac files are installed in separate folders and will not cause any mismatch. The function of the PowerPacs will not be affected.

**Only possible to open one SafeMove Configurator at the time**

Only one SafeMove Configurator may be open at the time, even though several controllers may be connected. If the SafeMove Configurator is opened for one controller, the icon will become disabled for the other controller. This limitation also includes Offline, i.e. if SafeMove Configurator is opened in Offline, then it cannot be opened in Online for another controller and vice versa.

**Compatibility of RobotStudio Library and Stations with older RobotStudio versions**

RobotStudio is generally not forwards compatible, i.e. it is not possible to load stations or libraries created in RobotStudio 5.60 into an earlier version of RobotStudio such as e.g. RobotStudio 5.15.02 or earlier. However, RobotStudio is backwards compatible, which means stations and libraries created in version 5.15.02 or earlier can be opened in RobotStudio 5.60.

5.2 Online

**SafeMove Tool Zone visualization in Online Monitor for robots with external axes**

Only TCP robots and track mounted robots will be visualized in the Online Monitor, no other external axes or positioners.

As a consequence, the Online Monitor may show the robot in a non-violating position, even though the safety controller has detected a safety violation and stopped the robot.

**FlexPendant Viewer running with automatic reloading**

When having FlexPendant Viewer running with automatic reloading of the screens and at the same time jogging the robot with the joystick the robot jogging might halt when the FlexPendant Viewer reloads.

**Restart of Controller when connected through the service port**

Re-connection of controller may fail when a controller is restarted from a service port connection.
5.2.1 Online - Paint

Backup for Paint systems does not create backup of the PIB board

The Backup function of RobotStudio does not create a backup of the PIB board of the IRC5P system.

**Workaround:** Create the backup of the PIB board with the FlexPaint Pendant using an USB-stick.

Go Offline does not work for Paint systems

The Go offline function will not create a working Virtual controller system for Paint system unless the Paint package I/O option is set to Simulated.

5.2.2 Online – Integrated Vision

Information – Integrated Vision only works on 32-bit installations

It is not possible to use Integrated Vision in the 64-bit version of RobotStudio.

Information – Camera firmware version and update

The minimum firmware version to be used with Integrated Vision is 4.08. If this version is not available for a specific camera model, then the newest version available shall be used.

There two things important things to know before upgrading a sensor

- The user must make sure to first backup the files on the camera. This can be done using the Rapid snippets for camera backup/restore, or the FlexPendant Explorer.
- The latest available firmware version may vary across sensor types. However, when the firmware update utility presents the latest available version it shows the firmware with the highest version number which may not apply to the sensor to be updated. However, the appropriate firmware will be applied.

Remaining error - Connect button greyed out for no reason

It may sometimes happen that the “Connect” button is greyed out, with the tooltip saying the the camera is not on the correct subnet although the IP settings are OK.

**Workaround:** Restart the Integrated Vision Add-In.

User tip - Removing cameras from configuration

To remove a configured camera from the list of configured cameras, use the configuration editor. Enter Configuration->Communication->Application Protocols and remove the desired camera. Perform a warm start to complete the operation.

User tip - Use default camera settings

If the camera is not using default communication settings the result may be that RAPID instructions return error code “Communication Error”. The safest method to get default settings is to go to Connect->Add Sensor Right click and select “Show all sensors”. Select the device to reset and click “Apply factory settings” in the lower right corner. The most important settings are:

- Telnet port: 23
- User: “admin”
- Password: “”
**User tip – Viewing all cameras present on the network**

Connect->Add Sensor is normally used for setting the IP addresses of sensors that are not currently on the correct subnet (192.168.125.X). Since the dialog shows all cameras “seen” by the PC, this dialog is useful when error tracing camera network problems.

**User tip – Warm start the controller after changing network settings**

Whenever changing the network settings of the camera, either from Connect->Add Sensor or Connect->Network settings, it is important to warm start the controller. If this is not done, RAPID instructions will give the error “Communication Error” and the FTP-mounted camera disk is not accessible. If DHCP address is used and persists, please try a static address instead.

**User tip – Camera does not appear on network**

If a camera does not appear on the network using the “Add sensor” dialog as suggested above, it is advisable to cycle the power of the camera. If the camera receives power from the controller, then cycle power by turning the mains switch.

5.3 Offline

5.3.1 General

*Update of current selection in the 3D graphics window may be delayed*

A problem related to the graphics driver has been observed on certain PCs. The problem is that the update of the current selection in the 3D graphics is delayed until the next redraw.

**Workaround:** Add or uncomment the following line in the file RobotStudio.exe.config

```
<add key="DoublePresentWorkaround" value="true" />
```

*Failure to open Pack&Go file to same folder the second time*

RobotStudio will prevent Pack&Go files to be opened to the same folder a second time if the station contains VC systems with the EPS or SafeMove option. This is by design to prevent the safety controller configuration file to be accidentally overwritten.

**Workaround:** Remove the write protection manually using Windows Explorer.

**Updates of instruction template and code snippets**

RobotStudio will not automatically update the user files for instruction templates and code snippets files in the folders:

```
...\My Documents\RobotStudio\Instruction Templates
...\My Documents\RobotStudio\Code snippets
```

**Workaround:** The user has to manually copy the latest files from

```
%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Instruction Templates,
```

and

```
%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Code Snippets
```

* to the data folder.
IO signals configured with access level ‘DEFAULT’

When IO signals are configured with access level ‘DEFAULT’, only input signals are possible to set/reset from the I/O Simulator and I/O Window. To be able to affect also output signals, set the access level to ‘ALL’ for them in the Configuration Editor.

VC does not start with RRI option and GSI folder structure missing.

The VC will hang when started with a system containing the RobotWare option RRI (Robot Reference Interface) if the GSI folder structure is missing.

**Workaround:** create GSI Folder before starting the VC inside the HOME directory of the system. See the Application Manual for Robot Reference interface for more information.

System in Guard Stop state in Automatic mode after run-time error

Certain run-time errors may cause the controller system to enter Guard Stop state in Automatic mode. This is the same behavior as in a physical robot controller system. This typically happens when a run-time error related to Conveyor Tracking occurs. A simulation cannot be started when the controller is in this state.

**Workaround:** To reset the controller state, open the Control Panel window and first switch to Manual mode, and then back to Automatic mode.

Information message starting system with IRB260/460/660/760

Starting a system with IRB260/660 gives you an error message: ‘The number of joints is different between the library model and the controller configurations’. The reason is that the IRBx60 is modeled with six joints in RobotStudio of which two are locked, but has four joints in the VC.

Path handling of instructions with multiple joint targets

The path functions Rotate, Translate, and Mirror do not work as expected with instructions containing via points as joint targets. The functions will leave the joint targets as is. Interpolate Path gives an Unknown Error and Tool Compensation reports an error message.

Event Manager: Simulation cannot be triggered by analog system signals

The event manager only supports analog station signals, not analog system signals.

5.3.2 Station Viewer

*The command Record to Viewer is only enabled in Time Slice mode

The command Record to Viewer requires the Virtual Time mode of the RobotStudio Options to be set to Time Slice. Otherwise, i.e. if the Virtual Time mode is set to Free Run, the button will be disabled.

**Workaround:** Enable Record to Viewer by setting the Virtual Time mode to Time Slice.

Memory problem when doing Save As Viewer or Record To Viewer with large stations

RobotStudio may run out of memory (OutOfMemory exception) when doing Save As Viewer or Record To Viewer if the station is very large.

**Workaround:** Use the 64-bit version of RobotStudio and create a 64-bit viewer by ticking the checkbox in the Save As Viewer file dialog.

5.3.3 Signal Analyzer

Maximum 26 signals can be exported

The number of signals that can be exported to Excel is limited to 26.
5.3.4 MultiMove

Definitions for Workobject and tooldata must be specified in each task

Workobjects and tooldata that are shared (i.e. declared as PERS) between several tasks must be specified in RAPID with its full value for each task when programming offline with RobotStudio. This will give rise to the warning ‘Initial value for PERS not updated’ in the controller event log. The warning can be ignored in this case. However, you must carefully ensure that the RAPID variable definitions are the same in all tasks, otherwise you may get unexpected behavior.

Include MultiMove option for system with several TCP robots

When creating a system for several manipulators (up to four) with SystemBuilder, either of the RobotWare options MultiMove Independent, or MultiMove Coordinated must be included for all of the related motion tasks to start.

Note

It is recommended to use the function System From Layout if applicable when creating robot systems for RobotStudio. Then the MultiMove option will automatically be added whenever required.

MultiMove error: ‘Object reference not set to an instance of an object’

When the Test Play button is pressed in the MultiMove tool, the following error message may be displayed: ‘Object reference not set to an instance of an object’, but the robot moves and the Status ‘Calculation OK’ is displayed. In addition, when ‘Create Paths’ is pressed the following message is displayed: ‘Can't create paths : Value cannot be null’, and no paths are created. In the ‘Create Paths Settings’, is the WP TCP drop down empty.

Reason: wobj is not set for the current task

5.3.5 Virtual FlexPendant

The FlexPendant Option ‘Non Motion Execution’ is not supported

The FlexPendant has the option ‘Non-motion Execution’ that can be set to prevent the real controller from moving even though the program is executing. RobotStudio will ignore this option and move the robot anyhow.

Controller switched to Automatic mode when RAPID instruction UiShow is executed

RobotStudio will automatically request mastership to the controller to update a data value, whenever the RAPID instruction ‘UiShow’ instruction is used. This will only happen if the Virtual Operator Window is enabled. When starting Virtual FlexPendant with enabled Virtual Operator Window, a message window is launched, explaining that unexpected behaviour may occur.

Workaround: Disable the Virtual Operator Window in RobotStudio options.

Automatic mastership when interaction required in Virtual Operator Window

RobotStudio will automatically request mastership when committing data to the controller, when actions are taken in Virtual Operator Window. This can cause undesired effect when using the Virtual FlexPendant at the same time.

Workaround: Disable the Virtual Operator Window in RobotStudio options.
Virtual Flex Pendent: Emergency Stop button

When the emergency stop button is pressed on the Virtual FlexPendant, it cannot be reset through the VC Control Panel. The button must be reset on the Virtual FlexPendant

5.3.6 External Axis

Error 50091: ‘Restart not possible’ after warm start of a system with external axis

When restarting a system with activated mechanical units the activation state is lost. Then the program can no longer be started from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window.

Workaround: Reset the program pointer (‘Program Pointer to Main’) before starting the program from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window, or, start the program from the Simulation Play button.

JointTargets for external axis

JointTargets for external axis are not visualized in the graphical window.

5.3.7 Network Drives and UNC Paths

RobotStudio on computers with roaming user profiles

RobotStudio may fail on PC configurations with roaming user profiles, i.e. when the users’ documents folder resides on a server and not on the local disk.

Workaround: Redefine the ‘User Project Folder’ to a folder on the local disk (File → Options → General → Files&Folders → User Project Folder).

Virtual Controller does not support UNC paths

UNC paths cannot be used to locate Virtual Controller systems. Using UNC paths for VC systems will cause the log message ‘Failed to initialize FW upgrade framework’ to appear when the system starts. Subsequent attempts to work with the VC such as synchronizing RAPID data will fail.

Creating and starting systems located on a network drive

When using a network drive to store RobotStudio data such as RobotWare systems or the RobotWare mediapool, the following problems may occur

- Virtual controller does not start
- Not possible to open VirtualFlexpendant

Cause: By default, the .NET Framework does not allow execution of code from a remote file system. This means the application may behave unexpectedly if the media used by the system or the system itself resides on a network share.

Workaround: To resolve this, the user must explicitly grant the required permissions:
1. Open the file Virtual FlexPendant.exe.config located in
   C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.60\Bin
2. Add the following lines

```xml
<?xml version="1.0"?>
<configuration>
  <startup useLegacyV2RuntimeActivationPolicy="true">
    <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/>
  </startup>
  <runtime>
    <loadFromRemoteSources enabled="true"/>
  </runtime>
</configuration>
```

© Copyright 2013 ABB All rights reserved
The Virtual FlexPendant must be restarted for the changes to take effect.
For further information, see

Note

Windows security settings may prevent the file from being directly edited in the default location. Copy the file to your local Documents folder to edit it. Upon completion, you need to manual copy the file back to its original location.

5.3.8 RAPID

RAPID Profiler limitations

- The Spy function does not produce useful output for systems based on RobotWare option CAP (Continuous Application Platform). This is the case for e.g. systems with the RobotWare options Arc and RW Cutting. This affects the RAPID Profiler that analyses the log generated by the Spy function.

- The RAPID Spy function, which produces the input to the RAPID Profiler, measures **RAPID program execution time** as opposed to motion execution time. In many cases, however, it is the motion execution time that is of interest. To make these two times coincide for the RAPID procedures, ensure that the last move instruction of all procedures is a so-called stop point, e.g programmed with speedata fine. Otherwise, the RAPID instruction execution time will be lower than the motion execution time. The reason is that the program execution runs ahead of the motion execution unless the programmed point is a stop point. Read more about stop points in the **RAPID Reference Manual** included with RobotStudio. In particular, see zonedata and stoppointdata.

Breakpoints deactivated when running simulation.

When running a simulation (Simulation Play) in time slice mode, all breakpoint set in the RAPID editor window(s) will be deactivated temporarily. This will prevent a situation, which may cause RobotStudio to hang, when a hitting a breakpoint during simulation.

Error Message: Sync. to Station completed with errors

Error Message: Sync to Station completed with errors: New data <name> <type> has same name as existing object in same block <routine>.

When this error message appears, there is a storage type mixup between data already stored in RS and in the VC. Because of this, and per design, the data is not considered the same data.

**Workaround:**

1. Ensure all data declarations have the same definition in RS as in RAPID (there is no user interface for this).
2. Sync to station should now work.
3. Sync back to controller, and remember to change the data declarations back to what you want.

Array of robtargets, tooldata and workobjects are not supported

RAPID programs containing arrays of tooldata, robtargets and workobjects are not supported, i.e. they will not be synchronized to the station.
The RAPID functions Offs and RelTool are not fully supported

RobotStudio does not fully support instructions using Offs or RelTool functions. They will be synchronized and will appear in the element browser, but commands such as “View Tool at Target” and “Locate Target” will not work. Targets used in the instructions will not be visible in the graphics. However, instructions can programmed and edited using the RAPID Editor and successfully simulated using the VC.

5.3.9 Building Controller systems

Virtual Controller systems must be I-started after Modify System

A virtual controller system that has been modified using the function Modify System of the System Builder must be I-started for the changes to take effect.

Modify system with additional Mediapool(s) not in default location.

Trying to modify a system, which references one or several additional options mediapools not placed in the same folder as the used RobotWare mediapool, will cause the System Builder to fail to modify the system. Workaround: Copy the additional options mediapool to the default mediapool location (i.e. %ProgramFiles%\ABB Industrial IT\Robotics IT\Mediapool.)

Not possible to Modify System for Pack and Go file.

It is not possible to use the function Modify System of the System Builder for a system that uses a mediapool embedded in a Pack&Work file.

Workaround: Copy the mediapool to the common Mediapool folder, and create the system from the backup

System From Layout requires custom made track motion to be saved as library

The System From Layout requires that any custom made track motions used to be saved as library

Move/Copy of Virtual Controller systems

Warm-started systems cannot be moved to another location and/or PC. This will result in a non-working VC.

A typical symptom of the problem is that the Virtual Controller reports Failed to retrieve procedure.

Workaround and recommended method of working:

1. Use ‘Pack & Go’ to pack the station and system backups in a zip file.
2. Use ‘Unpack & Work’ to unpack the zip file created by ‘Pack & Go’.

5.3.10 Paint

Lack of Virtual Controller support for the Paint systems

Paint systems that are configured using the Paint package I/O option Discrete, Compact or Fieldbus, will result in a SysFail state.

Workaround: Re-create the system with the simulated I/O option.

No Virtual FlexPaint Pendant available

There is no Virtual FlexPaint Pendant available for Virtual Controller systems with paint robots.

Workaround: Use the regular Virtual FlexPendant instead.
Hidden main entry point for Paint systems

Controller systems for Paint robots (IRB5XXX) has a hidden main procedure to handle the so-called job-queue. This is why the user must define a new entry point, e.g. main2, using the Setup Simulation tool to avoid conflicts when working with a paint robot in RobotStudio.

Only single robot setups supported for Paint systems

It is possible to create the system with System builder for both single & multi paint robot systems using Virtual Key & Paint option. But a System failure will occur starting the Multi paint robot system. Only Single paint robot system can be started.

5.3.11 Conveyor Tracking

Circular Conveyor Tracking not supported

RobotStudio does not support tracking of circular conveyors. Only linear conveyors are supported.

Compiling a Conveyor Mechanism does not disable the Compile button

After compiling a conveyor mechanism, using the Create Mechanism tool, the Compile Mechanism button is not disabled. If the user presses the Compile button again, without changing anything, another identical conveyor mechanism will be created.

Conveyor Tracking programs must be started with the Simulation-Play button

It is not possible to successfully run a RAPID program with Conveyor Tracking from the Virtual FlexPendant or from the RAPID Editor. The reason is that RobotStudio must simulate the Conveyor Encoder Unit in order to provide the required I/O signals to the system. This is only possible when running a simulation.

Workaround: Start the simulation with the Simulation-Play button of RobotStudio instead of the Virtual FlexPendant or the RAPID Editor.

The same part can only be attached once on a Conveyor

It is not possible to attach the same part on a conveyor more then once.

Workaround: Import the same part several times, or copy and paste the part in the Layout browser, before attaching them to the conveyor.

Note

The part must not be attached to the conveyor during the copy and paste operations, then the copy will get the wrong transform.

5.3.12 Graphics and Geometry

*RobotStudio only supports STL files in ASCII format

The STL format specifies both ASCII files as well as binary files. RobotStudio only supports STL files in ASCII format.

*Conversion of ProE/Creo files fails for RobotStudio 64-bit edition on Windows 8 / 8.1

ProE and Creo files of type .prt and .asm cannot be converted in the 64-bit edition of RobotStudio or the 64-bit edition of the standalone CAD Converter.

Workaround: Convert the file to SAT using the 32-bit CAD Converter or RobotStudio and load the SAT file into the 64-bit edition of RobotStudio.
Load station without geometry

Opening a station with the option ‘Load Geometry’ unchecked, followed by saving the station, will cause the geometry (underlying CAD data) to be permanently removed.

Workaround: None.

The Healing option may increase size of CAD models

The healing option may be used during CAD import to try and heal CAD-models. For some CAD-models the size is increased a factor of ten.

Workaround: Uncheck the Healing option in the Import Geometry dialog or the CAD-converter.

Problems when undoing Boolean operations on Geometry

Undoing a Boolean operation might not succeed. To recover from these problems, you need to delete the items that caused the problem.

Out of memory

The application might fail when out of memory due to the import of very large ACIS files or load of very large stations.

Workaround: Use the 64-bit version that can handle more memory. Ensure that you have enough memory installed on the PC, see System Requirements.

5.3.13 Gearbox Heat Prediction Tool

Only support for one robot in each VC

When a virtual controller has more than one robot, only one robot will have predictions calculated. The other robots will only display 0% chance of overheating.

5.3.14 External Axis Wizard

Paint systems not supported

Paint systems are not supported by the External Axis Wizard

5.4 ScreenMaker Limitations

Undo Redo support

Undo and Redo operations in ScreenMaker is not supported.

Dynamic update of Rapid Data

The switch from Manual Mode to Auto Mode causes the RAPID boolean data bound to the enabled property of control change to value TRUE. This behaviour is noticed when the mode is changed from a different screen and not on the screen where the control is bound to RAPID boolean data. An additional side effect is that the enabled property of RunRoutine button has been disabled as similar behavior was seen.

Not possible to add sub menu items on Command Bars

The FlexPendant controls have the ability to have sub menu items when a command bar button is pressed. This is not supported.

Not possible to add signals to ListBox / ComboBox

When adding items to the ListBox/ComboBox control, it is not possible to add I/O signals
**Group box controls with Numpad**

NumEditor control is placed as a sibling of the GroupBox. Numpad control gets opened on clicking the NumEditor. If NumPad does not fit inside the parent of NumEditor, in this case the GroupBox, the controls that were disabled by NumPad are not enabled again.

The workaround is to make sure that the numpad fits inside the parent of the NumEditor,

You must also avoid scenarios where the NumEditor is put outside a GroupBox (or any other control) where the Enabled property of any child control is bound to controller data.

If all controls of a ScreenMaker screen are siblings it should be fine when using the NumEditor while binding Enabled properties of controls.

**Unicode characters not supported**

When creating a new SM project you are not allowed to use chars like "åäö".

**Adding ScreenMaker.sys file**

The following error occurs if ScreenMaker.sys entry is not available in SYS.CFG file of robot system.

To overcome this copy the following entry shown below

- File "RELEASE:/options/gtpusdk/ScreenMaker.sys" -ModName "ScreenMaker"\-AllTask -Hidden

And paste it under CAB_TASKS_MODULES in the file SYS.CFG

Save and Load the modified SYS.CFG file back into the robot system. Warmstart the robot system.
Running Routine with Movement

RunRoutine Button control does not always work correctly when a routine with movements is called.

As a workaround use instructions like StopMove, StorePath, RestorePath and StartMove to control the movements of the robot.

A Trap routine could be called with a normal button control and in the Trap the above instructions can be used to control the movements of the robot.

PictureBox control as a Widget

If a Picture Box control is created as a widget from a Windows 8 operating system, the control is not shown on the FlexPendant. The behavior is fine with any other operating system like Windows 7.
6 RobotWare Compatibility

6.1 General

Supported RobotWare versions

RobotStudio 5.15 is distributed with RobotWare 5.15 and works with RobotWare 5.05 and later. Please see below for details.

6.2 RobotWare 5.05 and 5.06 Compatibility

RobotWare 5.05 and 5.06 including revisions thereof are not supported by RobotStudio 5.15 and later versions. Please use the corresponding version of RobotStudio for managing robot controllers with any of these RobotWare versions.

6.3 RobotWare 5.07 Compatibility

RobotWare 5.07 and its revisions of are supported with the following limitations:

General

The location of the program pointer is not updated in the RAPID Editor during program execution.

Offline

A limitation in the versions 5.07.02, 5.07.03, and 5.07.04 of RobotWare may cause the Virtual Controller to System Failure state during I-start on certain computers. The problem is due to the ctrl.bin-file not being correctly created.

Workaround: Create an empty ctrl.bin file in the INTERNAL folder of the controller system, and then perform a warm start.

The virtual controller does not support RobotWare 5.07.08 and RobotWare 5.07.07.

Online

FlexPendant Viewer does not work RobotWare 5.07

6.4 RobotWare 5.08 Compatibility

RobotWare 5.08 and its revisions of are supported with the following limitations:

Offline

RobotWare 5.08 is not supported.

Workaround: Use RobotWare 5.08.01 or later.

6.5 RobotWare 5.10 Compatibility

RobotWare 5.10 and its revisions of are supported with the following limitations:

Offline

Starting a controller will generate internal UAS error in controller error log.

Note

The problem will reappear if the system is I-started.

© Copyright 2013 ABB All rights reserved
6.6 RobotWare 5.11 Compatibility

RobotWare 5.11 and its revisions are supported with the following limitations:

Offline

Linear jogging of a robot across joint values that will cause a change of confdata may fail. For example, if the robot is jogged linearly when joint values is passing 90 degrees for axis 1 may cause the robot to stop or to change configuration.

6.7 RobotWare 5.12 Compatibility

RobotWare 5.12 and its revisions are supported with the following limitations:

Paint backups from RW 5.12.01 not compatible with RW 5.12.02 or later

Restoring a paint system backup from RobotWare 5.12.01 will cause SysFail for RobotWare 5.12.02 or later

Workaround: Add the following parameters to the configuration files

**EIO.CFG:**

```
EIO_SIGNAL:
   -Name "doMainInMC" -SignalType "DO" -Unit "SysComm" -UnitMap "44"
   -Name "ALHVErrNo" -SignalType "DO" -Unit "SysComm" -UnitMap "150-151"
   -Access "ALL"
   -Name "ALHVEn" -SignalType "DO" -Unit "SysComm" -UnitMap "155"
   -Access "ALL"
EIO_CROSS:
   -Res "ALHVEn" -Act1 "HVEnabled"
```

**SYS.CFG:**

```
CAB_TASK_MODULES:
   -File "INTERNAL:/pntrapid/T_ROB1/cycinfo.sys" -ModName "cycinfo"
   -Task "T_ROB1"
   -File "INTERNAL:/pntrapid/csvlkup.sys" -ModName "csvlkup" -AllTask
   -Hidden
```

6.8 RobotWare 5.13 Compatibility

RobotWare 5.13 and its revisions are supported with the following limitations:

Paint backups from RW 5.12.02, 5.12.03 or RW 5.13 or 5.13.01 not compatible with RW 5.13.02 or RW 5.13.03

There are several changes in the configuration database for I/O (EIO.CFG) and Controller (SYS.CFG) that will cause System Failure if an old backup is loaded. There are also changed in installed RAPID modules. To create a compatible configuration, proceed as follows:

1. Create and start a VC with a RobotWare 5.13.03 system containing the same options as your original backup, but do not load the backup.
2. Save the EIO.CFG and SYS.CFG to file.
3. Compare the saved files with the corresponding files of your backup. (You can use a text file comparison tool for simplification.)
4. Add your system-specific configuration to the general configuration files saved from the 5.13.01-system using a text editor.
5. Replace the files of the original backup with the corresponding modified configuration files.
6. Go through the RAPID modules of the backup and remove the default modules (i.e. those that are not changed by the user).
7. Load the backup and restart the system. You are done.

6.9 RobotWare 5.15 Compatibility

*Signal Analyzer Online*

The feature Signal Analyzer Online requires RobotWare 5.15.01 or later.

6.10 General Compatibility Limitations

**RAPID Profiler**

The profiler will be able to create a log file for the profiler automatically for RobotWare 5.14 or later. For RobotWare 5.13 or earlier, the log file must be created manually using the RAPID Spy command (SpyStart/SpyStop).

**Safety Configuration**

Safety configuration of a track motion IRC5 system equipped with a safety controller of type EPS or SafeMove can be done without the need to read track motion parameters manually when using RobotWare 5.11.01 or later. Encrypted parameters needed by the safety controller will be automatically read by EPS Wizard and SafeMove Configurator, respectively.

**Signal Analyzer Online**

Signal Analyzer Online requires RobotWare 5.15.01 or later.

**Signal Analyzer.**

The error message *Failed to subscribe on signal* may sometimes appear during signal recording for RobotWare 5.15 or earlier.

*Workaround: Restart the VC or upgrade to RobotWare 5.15.01 or later.*

**Configurations**

The feature *Configurations* for selecting the robot arm configuration (confdata) may fail, or not present all solutions, in some specific circumstances even when the target is reachable if RobotWare 5.14 or earlier is used.

*Workaround: Upgrade to RW5.14.01 or later*

**Virtual FlexPendant**

For RobotWare 5.15 and earlier the Virtual FlexPendant may become blank. Another symptom of this problem is that the controller browser is not expandable.

The problem is due to in incomplete startup of the virtual controller.

*Workaround: I-start the virtual controller or use RobotWare 5.15.01 or later.*

6.11 ScreenMaker Compatibility

**RobotWare**

It is possible to use previous RobotWare versions, but with some limitations.

- ActionTrigger will work only on RobotWare 5.12.02 or later.
- The controls Button, TpsLabel and PictureBox controls was modified in RobotStudio 5.13. The property 'Allow MultipleStates' of these controls can be accessed from RobotWare 5.13 and later.
- Variant Button will work only on RobotWare 5.14.01 or later
•Conditional Trigger will work only on RobotWare 5.14.01 or later
•Widgets will work only on RobotWare 5.60 or later.

FlexPendant SDK
ScreenMaker should be used with FlexPendant SDK 5.12.02 or later. ScreenMaker allows selection of FlexPendant SDK version when it is launched. If only one version of FlexPendant SDK is available in the system, it is loaded by default.

6.12 Support for future RobotWare versions
RobotStudio 5.60 supports all future minor revisions of RobotWare 5.60, but no future major releases. For example, RobotStudio 5.60 will support RobotWare 5.60.01 (if, and when available) but not RobotWare 5.61, or 6.x..
7 Installation information

7.1 Installing RobotStudio

Installation Instructions

RobotStudio 5.60 will be installed side-by-side with any previous installation of RobotStudio. It uses the same activation key.

RobotStudio requires RobotWare to be installed. Optionally, the Track mediapool may also be installed to add support for the track motions IRBTx004.

How to install RobotStudio on a PC

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Insert the robot software DVD in the PC.</td>
</tr>
<tr>
<td>• If a menu for the DVD is opened automatically, continue with step 5.</td>
</tr>
<tr>
<td>• If no menu for the DVD is opened, continue with step 2.</td>
</tr>
<tr>
<td>2 On the Start menu, click Run.</td>
</tr>
</tbody>
</table>
| 3 In the Open box, type the drive letter for your DVD drive followed by: \\
  :\launch.exe \\
If your DVD drive has the letter D, then type: D:\launch.exe |
| 4 Click OK. |
| 5 Select the language for the DVD menu. |
| 6 On the DVD menu, click Install. |
| 7 On the installation menu, click RobotStudio. This opens the installation wizard, which guides you through the rest of the software installation. |
| 8 After installing Robotstudio, you can proceed with installing RobotWare. Go to the installation menu, and click RobotWare. This opens this installation wizard, which guides you through the rest of the RobotWare installation. |
| 9 This step is optional, and is for installing the Track mediapool. On the Install products menu, click Additional Options. This opens a file browser that displays the Track mediapool installation and other available options. Double-click the TrackMotion folder and then the file setup.exe to start the installation wizard and proceed |

Note

For an immediate trial period of 30 days, RobotStudio will work without activation.

Knowing which RobotStudio version is installed

The version number of your RobotStudio installation is displayed on the RobotStudio title bar.

Activation of RobotStudio license

Activation of your RobotStudio installation is a procedure for validating your RobotStudio license. To continue using this with all of its features, you must activate it. RobotStudio Product Activation is based on Microsoft anti-piracy technology and is designed to verify that software products are legitimately licensed. Activation works by verifying that the Activation Key is not in use on more personal computers than are permitted by the software license.

When you start RobotStudio for the first time after installation, you are prompted to enter your 25-digit Activation Key (xxxxx-xxxxx-xxxxx-xxxxx-xxxxx). The software performs in the Basic Functionality mode if you do not use a valid Activation Key.
After the installation is activated, you will have valid licenses for the features covered by your subscription.

**Note**

Activation is not required for Minimal installation, or for Basic Functionality mode of the Complete or Custom installation.

### What is Basic Functionality mode

In Basic Functionality mode, which is a reduced functionality mode, RobotStudio allows only the use of the basic features for the real and the virtual controller. No existing files or stations are harmed in this mode. After activating your software, you will have full functionality for the features you have purchased.

A real controller can be programmed, configured and monitored over Ethernet without activating your installation of RobotStudio. Activation, however, will provide access to the Premium productivity features that will make your engineering work more efficient.

### How to activate RobotStudio

Use the Activation Wizard to activate your RobotStudio installation. When you start RobotStudio for the first time after installation, the wizard starts automatically and prompts you for the Activation Key. If you do not want to activate your copy of RobotStudio at installation, you can do so later using the Activation Wizard.

**Note**

If you have a problem with your activation, contact your local ABB customer support representative at the e-mail address or telephone number provided at [http://www.abb.com/contacts](http://www.abb.com/contacts).

For using the Activation Wizard, follow this procedure.

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. On the <strong>File</strong> tab, click <strong>Options</strong> and go to <strong>General:Licensing</strong>.</td>
</tr>
<tr>
<td>2. On the Licensing page to the right, click <strong>Activation wizard</strong> to launch the Activation Wizard.</td>
</tr>
</tbody>
</table>

In the Activation Wizard, on the **Activate RobotStudio** page, indicate whether you have a **Standalone License** or a **Network License**, and then click **Next**.

If you have chosen **Standalone License**, you will proceed to the **Activate a Standalone License** page. See **Activate automatically over the Internet or manually** below for further steps.

If you have chosen **Network License**, you will proceed to the Network License page. See the **RobotStudio Operating manual** for further steps.

### Activate automatically over the Internet or manually

The Activation Wizard gives you two choices on how to proceed. You can choose either automatic activation over the Internet or manual activation. These are explained in the following section.

#### Automatic Activation (recommended)

In Automatic Activation, the Activation Wizard automatically contacts and sends your activation request to the ABB licensing servers over your Internet connection. Your license will then be automatically installed and your product will be ready for use.
For Automatic Activation you need a working Internet connection and also a valid Activation Key that has not exceeded the number of installations allowed. RobotStudio must be restarted after the activation has been successfully completed.

**Note**

If you choose to activate over the Internet but are not currently connected to the Internet, then the wizard alerts you that there is no connection.

**Manual Activation**

1. If the computer does not have a working Internet connection, you must proceed with Manual Activation:

2. Create a license file by selecting the option **Step 1: Create a license request file**. Proceed through the wizard, enter your Activation Key and save the License Request File to your computer.

3. Use a removable storage medium, such as a USB stick or floppy disk, to transfer the file to a computer with an Internet connection. In that computer, open a web browser, go to [http://www101.abb.com/manualactivation/](http://www101.abb.com/manualactivation/) and follow the instructions given.

   The result will be a License File that should be saved and transferred back to the computer having the installation awaiting activation.

4. Relaunch the Activation Wizard and go through the steps until you reach the **Activate a Standalone License page**.

5. Under **Manual Activation**, select the option **Step 3: Install a license file**.

   Proceed through the wizard, selecting the License File when requested. Upon completion, RobotStudio is activated and ready for use.

   RobotStudio must be restarted after the activation has been successfully completed.

**How can I tell whether my RobotStudio installation has already been activated?**

1. Go to the **File** tab, and then click on the **Options** button, and select the **Licensing** section.

2. Click **View Installed License Keys** to see the status of your current license.

3. If your RobotStudio installation is activated, you will have valid licenses for the features covered by your subscription.

**Network licenses**

Network licenses are available for schools and ABB certified partners.
8 Technical support

8.1 Overview

Contacting ABB

If you have any questions or problems with your RobotStudio installation, please get in touch with your local ABB Robotics Service representative, see http://www.abb.com/contacts.

Have the following in mind

1. Running the latest version of RobotStudio help ensure that it works properly and includes improvements and new product functionality. ABB recommends that you update to the latest version of RobotStudio whenever a new version is available and before contacting ABB for support.

2. Give a brief description of how to reproduce your problem.

3. Create screenshots if applicable. (Use ALT + PRINT SCREEN to get an image of the active window instead of the entire screen.)

4. Generate a Full Scan with the RobotStudio Support Tool available next to RobotStudio in the Start menu, save the report and attach it with your problem description. (Click Start → Programs → ABB Industrial IT → Robotics IT → RobotStudio → RobotStudio Support Tool, click on Run Full Scan and then Save Report.)

5. We also need the following user information:
   i. name
   ii. company
   iii. contact information
   iv. what operating system you are running (incl. language)
   v. subscription ID for your purchased license.
   vi. Machine ID, see Help section of File tab.

Note

When sending large (> 1 Mb) files, please compress them with WinZip® or WinRAR.

License support

For license-related questions, please contact the team responsible for license support directly at softwarefactory_support@se.abb.com